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Hello readers, I hope the SketchUp-Ur-Space team becomes able to fulfill your demands and 

questions through our every month publication. Every time with every edition SketchUp-Ur-

Space team try our best to preset some new and exciting SketchUp related things to you. 

In the beginning of this magazine, our hardworking team members tried their best to deliver 

best SketchUp related details or article to the readers so that SketchUp users and professionals 

can find their every needs here. But due to some changes in the Editorial team, we were unable 

to deliver the magazine every month but this year we decided to follow the trend again. That’s 

why from January we are continuously working on delivering best and useful news for our 

readers. 

Readers are our big assets who inspire us to find some new ideas and discussions on SketchUp-

Ur-Space magazine. SketchUp-Ur-Space team is researching on the detailed news of SketchUp 

and the result is in front of everyone. Ok let’s start this edition without wasting more time. 

In every single edition, being a SketchUp lover and admirer we try to focus on the things that 

will help readers in creating their 3D models. 3D models are the best way to share ideas, view 

future ideas and connect with other people all over the world. SketchUp is the best way of 

creating 3D models and using them for getting some better results. 

Our Magazine, SketchUp-Ur-Space never delays to deliver the latest news, tips and many more 

unique things about SketchUp for our valuable readers and our December edition is full of 

them. It has some trendy and exciting news for our eagerly waiting readers. 

SketchUp-Ur-Space is a well known and lovable magazine that consists with some useful news 

and data for the beginner and experienced SketchUp users, designers, architects etc. Our 

magazine’s editorial team always wants to give our readers new and interesting stories, news, 

blogs and many more other things to enhance the knowledge and skills. This January edition 

has come up with the same motto and various unknown surprising facts on 3D designing that 

will surely amaze you. 

The cover story of this edition talks about the review of Trimble’s Visiting Professional’s 

Program where SketchUp professionals from all over the world joined and discussed about their 

thoughts. 

In the Article section there are 4 relevant topics written by our editorial team that depicts 

about new features and extensions of SketchUp which will develop 3D printing more than 

before. The first article is about the new added features of SketchUp Pro 2019 version. 

SketchUp Pro is a well known version of SketchUp which is also a paid version; second one tells 

about the method of finding New favorite models in SketchUp; third one is the way of turning 

2D Topography or a Survey to Terrain in SketchUp and the last one is the way of breaking 3D 

model into Parts for 3D printing. 

The Blog section includes three reviews and one new announcement, such as: 1) About the 

Advanced Templates in SketchUp Pro 2019 , 2) The way of creating Polygon in SketchUp within 
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5 seconds; 3) Review of Helix Along Curve Plugin and 4) the new place for SketchUp lovers, 

SketchUp Campus. 

The Tips and Tricks section will help new beginners to be easy with SketchUp through some 

easy learning process of 1) Only focused on CleanUp3 from SketchUp; 2) Review of Tape 

Measure Tool; 3) About Maciej Fijalowski of VR SketchUp and 4) using pbr materials to move 

from SketchUp to Unity. 

Meanwhile the news section comes with different solving matters like 1) the way of Handling 

Extension License issues; 2) Methods of using 3D Printer with SketchUp; 3) to 5 Interior Design 

trends of SketchUp Hub and 4) SketchUp users will help in experiencing all realities. 

Huge topics are here to calm down your anxiety about working on 3D model in SketchUp and 

SketchUp Pro. Hope all our efforts can be helpful for you and help to solve your problems. For 

further queries please contact us through our email address. 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The whole team of SketchUp Headquarters has proudly announced the newest SketchUp 
subscription of SketchUp Pro 2019 where users can get all the favorite products to work. 

According to the developers, SketchUp Free is the simplest, consistent 3D modeling till date 
that will help the user to access, learn and share the models with others easily. It has been 
more than a year at SKetchUp Headquarters with huge amounts of coffee consumed and after a 
long wait, SketchUp HQ finally released SketchUp Pro’s new version SketchUp Pro 2019. 

NEW FEATURES ABOUT SKETCHUP PRO 2019 
 

Best wishes  

Subhra Bera 

Editor 

For any feedback and query please mail us 

at subhra@jobs2india.com  

Articles 

 

http://www.sketchup-ur-space.com/2019/june/new-features-about-sketchup-pro-2019.html
mailto:subhra@jobs2india.com
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The whole SketchUp team has been discussing to bring SketchUp lovers the newest 
development in the life of their products; they proudly announced a brand new way to 
purchase all the SketchUp products which is the SketchUp Subscription. They have offered the 
best value so that users and SketchUp lovers can easily choose the perfect combination of 
SketchUp for every project, workflow or creative concept. 

This is a real opportunity to challenge the team itself to earn users’ business every single day by 
continuously improving the tools which are needed and loved whole year. The new ways to buy 
SketchUp is on their website; still the team has been working to bring subscriptions for years as 
according them it is the best way to deliver more value to the users in a single package. Their 
shift in new business will make it easier for new users to buy SketchUp and for current users; 
even more SketchUp products can be easily available. Besides that, this shift in business will 
help to keep them accountable to run business by releasing new features as often as possible; 
this is a challenge for them which they have taken proudly and moved process from an annual 
update cycle to a continuous cycle. 

The new version has become faster and more powerful than ever before with bug fixes, system 
improvements and some wonderful new features. Here are a few of the highlighted features: 

SketchUp Pro 2019 for Desktop: Just need to Sign in and modeling will be started; everything in 
SketchUp-iverse is now combined together with one single account to make modeling, viewing, 
account management and many more. In SketchUp Pro & LayOut 2019, Layers now come with 
dashed lines which can allow simplifying drawings with effective drawing communications. 
While the Tape Measure tool can help to see measurement info in the modeling. 

LayOut: It will help the users to know which files are ready to open; in both SketchUp and 
LayOut there are many improvements t the .dwg import and export feature. There is also the 
ability to import and export with materials for better BIM interoperability and workflows. An 
“Export for SketchUp” feature between SketchUp and LayOut feature .dwg exporter will send 

all LayOut entitles along with any 
SketchUp viewport data to the model 
space. 

Trimble Connect: It will welcome 
users to a new world of efficient 
workflows and cloud collaboration; 
their 3D modeling sharing and 
document management tool is fully 
focused on projects related to building 
design and construction. 

SketchUp for Web: The team has 
added a ‘live preview’ for image 
exports; after signing in to SketchUp 
for Web when users open a model and 
go to File>Export>PNG, it will 
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recompose model as taking a snapshot at the desired image ratio. 

SketchUp Viewer for AR/VR: SketchUp Viewer is now also available on more VR headsets than 
earlier, just need to access to every single one with a SketchUp Pro subscription. Oculus, 
Windows Mixed Reality, VIVE and Hololens are all running SketchUp Viewer. 

SketchUp Campus: SketchUp’s official learning hub is known as SketchUp Campus where 
SketchUp-built courses all created by their in-house team that make SketchUp convenient abd 
simple in 104 languages. 

3D Warehouse: The 3D Warehouse has millions of models and 17 languages from where it is 
difficult to find the right thing on time so new version has come with categories which boasts 
better browsing, search refinement, subcategories and filtering by real products etc. that helps 
fast searching in less time. 

Sefaira: Those who are working in a firm that has a focus on performance-based design, 
SketchUp’s Safaira is like a subscription through SketchUp Radio. 

Source: www.blog.sketchup.com 

 

 

 

 

 

 

Google SketchUp team has been improving their tools and models continuously, at first they 
have released the new updated SketchUp Pro 2019 and then they released new 3D Warehouse. 

The whole SketchUp team has been discussing to bring SketchUp lovers the newest 
development in the life of their products; they proudly announced a brand new way to 
purchase all the SketchUp products which is the SketchUp Subscription. They have offered the 
best value so that users and SketchUp lovers can easily choose the perfect combination of 
SketchUp for every project, workflow or creative concept. 

About Extension Warehouse: It is an online resource with various plug-ins developed made 
especially for SketchUp and these extensions help to add some special tools and features to 
SketchUp. These extensions can be found for any particular application like drawing or 3D 
printing and some industry specified tools for architecture, interior design, construction and 
many more. So basically in this Extension Warehouse people can do the following things: 

o Users can search extensions by name or as per the functionality. 

o They can also install various extensions with a single click of a button. 

IT IS EASIER TO DISCOVER NEW FAVORITE 

MODELS IN SKETCHUP 

https://blog.sketchup.com/article/a-whole-new-way-to-sketchup
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o Or users can also control all the extensions from easy-to-use location in the My 

Extension page. 

But there are millions of models and 17 languages in the 3D warehouse of SketchUp Pro 2019 
tht makes it difficult to find the right one that can be used on the tools. SketchUp users have 
been facing this difficulty from a very long time so the SketchUp team has done something to 
fix this problem as they don’t want that their customers may miss their perfect model and they 
want to help in discovering som hidden gems in SketchUp 3D Warehouse. SketchUp team 
proudly announced the release of Categories on 3D Warehouse; these categories will help the 
users to easily search and browse in the world’s largest 3D model library. Here are the most 
improved features and the categories discussed that will help to figure the things out: 

 Better browsing: The new updated 3D Warehouse has come with better browsing 

experience to do the heavy lifting through the following steps- 1. At first users need to 

start with an “empty search”, 2. Then they have to select a Category, 3. There, they can 

watch the search results update and 4. Can get inspired. 

 Refining the search: The quality of search based as per the text of the author that uses 

to describe their model and if description doesn’t match with model the Selecting a 

Category will help to filter out the models that aren’t relate to the description. 

 Sorting by Subcategory: There will be millions of categories from which users can get 

their own models but if they want any specific one the Subcategory option will help to 

select the exact model. 

 Filtering by real-world 

products: Users can now 

search their needed buyable 

3D models from the 

Manufacturer Model filter 

option where they can easily 

find and buy models. 

 Categorizing the 

models: Categorization option 

in SketchUp 3D Warehouse 

has just begun which can be 

made better with the help of 

users like users can 

themselves categorize models 

as their own need. Actually 

categories make it easier to find right great content on 3D Warehouse, even there is no 

title or description or it can be in different language 

Source: www.blog.sketchup.com 

https://blog.sketchup.com/article/discover-your-new-favorite-models-easy


 
 

                           9 | P a g e  
 

 

 

 

Creating a SketchUp Topography or topographic map can be a huge painful work, but here we are going 

to discuss the process of creating topography in SketchUp through some simple steps. 

1. At first users need to import Google map into the project but before that the terrain 

must be toggled on. 

2. Then users have to create a grouped rectangle that covers the total site, next they can 

copy this rectangle up as per required increment or can copy all the rectangles and lastly 

group them together. 

3. Next users need to move their rectangles off to the side or can hide them so that the 

imported Google earth terrain can be seen. Then unlock and explode the imported 

terrain. 

4. After that, the grouped rectangles need to move over the terrain again or can unhide it. 

5. Users have to press Ctrl+A to select all, R-click on one of the groups; then they have to 

scroll down to Intersect Faces and Select with Selection. 

6. Hide or delete the slicing planes 

and the topographic map will be created. 

From a survey to 3D people are facing a 
little difficulty while transforming a 2D 
topography into a 3D terrain in SketchUp, 
this article is just going to focus on the 
problem and describing few steps to clear 
this matter. 

Importing the Image: 

o File > Import is the first step is to 

import the image that Users want to 

convert from a 2D survey to 3D terrain or 

topography. The following steps are: 1) 

select “import” from the file tab from the 

lower right dropdown menu and then 

select “supported image type”. 2) Image should be in a graphic scale so can it can be 

scald in SketchUp properly, at last select the right image and click “import”. 

o Next the image should be placed and roughly scaled to the correct size, for accurate 

scale select the tape measure tool and click from one end of the graphic scale to the 

other. 

TURNING 2D TYPOGRAPHY OR A SURVEY TO 3D 

TERRAIN IN SKETCHUP 
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o Next a message will appear on the screen asking if users want to resize the model with a 

pop-up named “ yes” it must be clicked before begin modeling of anything. 

o After that, users can change the view from perspective by navigating to “camera” and 

selecting “parallel projection”. Then select the follow path- camera > standard view > 

top which will give a top view to trace easily. 

Tracing Topography: 

 The first step starts with Tracing the perimeter property line and then tracing the 

topographic contour lines within the boundary with the help of Line tool. 

 Next delete faces using following path: click on “select” > “all with same material” and 

hit delete. 

Converting Survey to 3D model: 

press ‘ctrl’, click and drag mouse to select the property boundary lines, now click on “edit” and 
click make group option. Now move the 2D contour lines by selecting one and pressing the “up 
arrow” and type the needed height. Next highlight all the lines and deselect the property line 
from the following path: draw > sandbox > and select from contours. Now draw some 
additional contour lines beyond the property line replicating other contours, next select each 
line and change the height to correspond with the decreasing increments of the original 
contour lines and follow the steps again. 

Source: www.designerhacks.com/ 

 

 

 

 

SketchUp specialists Aidan Chopra has discussed a process which is simple enough for users 
who want to break their SketchUp models into parts for 3D printing. 

While doing 3D printing in SktechUp, users need to run into the need to spilt the model into 
parts. There are though some ideas are big to fit into the 3D printer’s build volume but other 
ideas want to be 3D printed in a rainbow of colored plastic or sometimes needs to be split to 
make it easy to print. 

Almost everything can designed in 3D with SketchUp and who have splattered in 3D drawing or 
are interested to learn the basics of design, SketchUp for Dummies has made it faster and 
easier to learn the ropes of a powerful, user-friendly tool that bring life into the design ideas. 
Users can get guidance here from creating a basic 3D model to showcase their work through 3D 
print or animation, literally everything in SketchUp that can help in anywhere like from 
redesigning the house to mocking up the future great invention. More than that, SketchUp’s 

BREAKING SKETCHUP MODEL INTO PARTS 

FOR 3D PRINTING 

https://designerhacks.com/how-to-turn-2d-typography-or-a-survey-to-3d-terrain-in-sketchup/
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vast usability has gotten very wide success as a tool that even non-designers can also make 
basic drawings; there are also many expert tips from former SketchUp product director Aidan 
Chopra and co-author Rebecca Huehls that help to draw and access SketchUp. 

Aidan has described a process which will help users to cut the SketchUp model in the right time 
and right way. 

Place to cut the SketchUp model: 

while subdividing a SketchUp model into printable parts, always users need to find the right 
place to start and to think what to do with the seams. Like if users want to go to sand, paint and 
finish the model then can do it and cut at any place but sanding and finishing is a huge work to 
do while it will become much easier if anyone make cuts and seams look like they are 
international parts of model. Another good place to hide a cut is at a change in elevation, 
curvature or color; if users place a seam where the surface of a part is interrupted already, it 
will not be noticeable enough. 

It is a good idea to pick something around us that is made of plastic and find the seams where 
the parts can combine together, and if that type of seam can be imitated people will notice and 
accept it faster. It will be seen as a realistic one and people will think that the 3D printed part 
came from a factory. If the constructions are large, then the only option may be to establish a 
grid and cut into build-volume-size blocks. 

Process to cut the SketchUp model: 

Cutting a model into parts is like using an Intersect Faces Tool to combine groups; users can 
simply place a piece of geometry as a cutter that will intersect with the larger object and 
become the new edges of the cut. For simple models in SketchUp Pro, users can use the Solid 
Tools to shorten this process, but for the complex models following steps need to do: 

o Select the group and make a new group around it where the original one will become a 
subgroup. 

o Then work inside the new group, create geometry in the shape of the cut. 
o After that, make new geometry into its own group. 
o Select Cutter Object> choose Edit> Intersect Faces with Context. 
o Inside each group, use Explode to stick the intersection lines, cutting object and base 

object. 
o Move back out to the master group and make copies. 
o In each copy, open the group for editing and erase unnecessary parts. 
o Run CleanUp3 on the new parts and use Solid Inspector2 to check accidental holes. 
o Place the parts back together as lines should be 

Source: wwww.dummies.com 

https://www.dummies.com/programming/google-sketchup/break-sketchup-model-parts-3d-printing/
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The SketchUp Extension Warehouse has uncounted kinds of extensions which come with their 
own licenses and if the license expired then problems occurred while working. 

About Extension Warehouse: 

It is an online resource with various plug-ins developed made especially for SketchUp and these 
extensions help to add some special tools and features to SketchUp. These extensions can be 
found for any particular application like drawing or 3D printing and some industry specified 
tools for architecture, interior design, construction and many more. So basically in this 
Extension Warehouse people can do the following things: 

HOW TO HANDLE EXTENSION LICENSE 

ISSUES 

News 
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o Users can search extensions by name or as per the functionality. 

o They can also install various extensions with a single click of a button. 

o Or users can also control all the extensions from easy-to-use location in the My 

Extension page. 

Extensions come with their connected licenses that enable users to use the extension. If an 
extension has a licensing problem, SketchUp won’t load the extension and an error message 
will be shown. The status column on this error will help users to diagnose the actual problem. 

Here is a list that will help users to outline the types of license errors and the way of resolving 
them: 

o Expired Trial: 

When an extension trial gets expired, users just need to buy the extension to continue using it. 

Users can buy the extension from the extension details page or from the My extension page. 

While downloading an extension from the Extension Warehouse through a web browser or 

from a developer’s website it will come as an .rbz file that can be installed manually. Here are 

the steps to follow before installing: At first go to SketchUp and select the Extension Manager 

Option form Window menu, after clicking on it the Extension Manager window appears. Now 

click on the Install Extension button. The Open Dialog box will appear where users can find the 

.rbz file, just save it to the computer, select the file and click OK in Microsoft Windows or Open 

in Mac OS X.SketchUp will warn the users about installing only extensions from trusted sources 

just click OK option for further procedure and the extension will be installed. Purchasing 

Extensions in the 3D Warehouse: Anyone can purchase an extension through signing in to the 

Extension Warehouse or through any browser or SketchUp; but it is essential to sign in to the 

Extension Warehouse through SketchUp before installing a trial version or buying an extension. 

Here are some needed steps that need to follow before a purchase: 

1. Go to the extension detail page and click the Purchase button. 

2. In the prompted option, users have to enter their billing and payment information, 

billing information will verify the credit card, the receipt is emailed to the email address 

that user uses to sign in to Extension Warehouse. 

The following steps is needed to install a trial or purchased extension: 

3. Go to the SketchUp and select the Extension Warehouse from Windows and sign in to 

the Extension Warehouse. 

4. Now search for the extension that is needed or go to the extensions details page and 

click Install Trial option. 

5. Then go to the user menu and select the My Extensions option. 
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6. The My Extension tab will open scroll down to the trial extension or the purchased 

extension to install and click on either the Install Trial or Install link. Click yes to install. 

o Not Licensed: This message indicates that SketchUp is not able to locate a license for the 

extension and if users installed the extension from the Extension Warehouse, then uninstall the 

extension, again restart SketchUp and again re-install the extension in some other way, next 

need to remove the extension manually and reinstall it form the Extension Warehouse. 

o License Limit Exceeded: Users can install a purchased extension on two different computers 

but it is installed in more than two, then this error will come. 

Source: wwww.help.sketchup.com 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

SketchUp users can create wonderful 3D models with the help of SketchUp and can print them 
in 3D way through the help of 3D printers; it is a way better combination. 

3D printing or additive manufacturing is way of making three dimensional solid objects from a 
digital life. The creation or making of a 3D printed object is achieved using additive processes 
and in this process, an object is made by laying down successive layers of material till the object 
is created. Each of these layers can be visible as a thinly sliced horizontal cross-section of the 
eventual object. So basically 3D printing is the opposite of subtractive manufacturing which is 
cutting out a piece of metal or plastic with for specimen a milling machine. 

USING 3D PRINTER WITH SKETCHUP 
 

https://help.sketchup.com/en/extension-warehouse/handling-extension-license-issues
http://www.sketchup-ur-space.com/2019/june/using-3d-printer-with-sketchup.html
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SketchUp and 3D printer are a perfect match; every new 3D printer’s manufacturer will come 
with documentation to help users in learning the way of using printers and the related 
software. The following information will focus on a few basic concepts of 3D printing that are 
often not explained well and users get confused about them. 

Aidan Chopra was a beloved member of the SketchUp team for 10 years; he is the creator of 
SketchUp Blog where SketchUp members and professionals share their new designs and tells 
some tips and tricks to design various designs that help users a lot. This Blog has attracted huge 
number of people and helps them to know more about SketchUp tools and extensions, 
moreover that users can now easily use SketchUp in their everyday life. Aidan also taught 
countless classes on SketchUp, he authored the SketchUp for Dummies Book. Users can get 
guidance here from creating a basic 3D model to showcase their work through 3D print or 
animation, literally everything in SketchUp that can help in anywhere like from redesigning the 
house to mocking up the future great invention. More than that, SketchUp’s vast usability has 
gotten very wide success as a tool that even non-designers can also make basic drawings; there 
are also many expert tips from former SketchUp product director Aidan Chopra and co-author 
Rebecca Huehls that help to draw and access SketchUp. 

Print often with 
SketchUp: We often assume 
that Desktop 3D printing is 
too much costly, but it is 
really, unbelievably and 
remarkably cheap. Let it make 
clear, look the cost for 
running a general desktop 3D 
printer is about 38.56 Rs/- an 
hour; after starting printer 
once it will continue working 
on design on its own. 
SketchUp models can be 
printed over and over and it 
will give perfect print every 
single time. 

Like Test Printers which are 
great in catching errors and 
mistakes; they are also a 
great way to document the 

evolution of a design. So always save a version of every SketchUp 3D model to print later and to 
find out the errors. Though there are some lacks also: these printers though use 3D printer’s 
Low Quality setting to print faster but come with a rougher surface, they can’t be edited after 
printing one time so it is better to keep copies. 
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Inside a SketchUp model: After creating the outer part of a model, it is way better to check out 
the inside part of a model as usually users let the 3D printer automatically do the inside part, 
filling it with automatically generated structure. But users can also make changes in them. 

Source: wwww.dummies.com 

 

 

 

SketchUp Hub always comes with new challenges every single time, this time they have come 
with Spring Design with some new ideas. 

About SketchUp Hub: Anita Brown has established the SktchUp Hub 3D Visualization and here 
are a range of courses for helping Interior Designers and students, creating exact floor plans 
and elevations with a professional touch for the extreme benefit of their business or studies. 
The SketchUp Hub’s total vision is to authorize Interior Designers especially women providing 
right technical abilities for making exact drawings and creative illusions at professional 
standards. Besides that, SketchUp Hub creates an available, engaged and fully supported 
learning environment for presenting the development of STEM related skills to a female driven 
industry. 

In the month of January this year, the Sketchup Hub had announced their first ever 5 Day 
Challenge where they had challenged designers and SketchUp users to create an awesome 
kitchen design with the help of Free SketchUp download. The event was a big successful one 
and many people showed their wonderful skills where the best got the winner prize and made a 
place for his/her design. After that the SketchUp Hub has focused on designing the Interior 
sides of houses with elevations, these elevations are actually some kind of visual tools that 
allow Interior Designers to transfer perfectly their vision for a space, specifically they can work 
on the design of a wall and other items within nearly view. 

After the January competition, SketchUp Hub is having a Spring Clean and has decided to adopt 
some of the more colorful and zesty interior design trends for this spring time. SketchUp Hub is 
shunning again their calm and cool Scandinavian vibe which will indulge much more vibrant and 
uplifting. This is a chance for the designers to step out from their comfort zone to incorporate 
colors, styles and patterns which they never tried as an Interior Designer. But before launching 
their final spring design, SketchUp Hub professional interior designers have made a list of things 
which should be included in the designs of competitors. 

Top 5 Interior Designer Trends for 2019: 

1. Color: Most interior designers are not comfortable using colors in their designs as they 

think it will provoke all kinds of nervous twitches, stone kicking and awkward silences. Though it 

is true that applying strong colors can be really scary thing but there are many other ways to 

add more color into lives without disturbing other decorations. It is the high time for designers 

SKETCHUP HUB’S TOP FIVE INTERIOR DESIGN 

TRENDS FOR 2019 
 

https://www.dummies.com/programming/google-sketchup/using-3d-printer-sketchup/
http://www.sketchup-ur-space.com/2019/june/sketchup-hubs-top-five-interior-design-trends-for-2019.html
http://www.sketchup-ur-space.com/2019/june/sketchup-hubs-top-five-interior-design-trends-for-2019.html
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to put more colors in their designs, playing with the contrasts to make their designs happier, 

lively and more vibrant to watch as it is the time for spring. 

2. Pattern: Another difficult task is to add pattern with color which is very difficult to show in a 

design, but the designers have to be brave enough to take this challenge. They can either play 

with one pattern or can mix and match different pattern types with vibrant colors. 

3. Natural Materials: Designers can use some natural materials such as wood, marble and 

seagrass to dominate interiors as it is the new trend of 2019. 

4. Mid Century Design: Applying Mid Century styling in the decorations adds a ridiculous amount 

of character and individually all types of interiors whether it is ultra modern, contemporary or 

traditional. A well designed, consistent design plan should have a good mix of styles where can 

be layers of shapes, here designers should be clever enough to highlight the basic interiors with 

Mid-Century touch. 

5. Mustard: Though designers are asked to add colors but SketchUp hub designers have specially 

focused on Mustard Color to add a different look in this Spring designs. 

Wish all the best to all the participants for their works. 

Source: wwww.sketchuphub.com 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

https://sketchuphub.com/spring-interior-design-trends-for-2019/
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Mixed reality technology is a game changer to visualize designs and design options; SketchUp 
Viewer has introduced Windows Mixed Reality to review and approve designs. 

The work process has changed a lot from past days, now the work is not bond in the desk or 
office anymore; actually it happens on the move. Now-a-days work has become more 
technology based and less place-based. The SketchUp Viewer family of products has dedicated 
from a long time to lubricating the wheels for their customers who want access to some simple 
and effective project collaboration tools on the world’s leading mobile and XR platforms. The 
SketchUp team has proudly announced the release of new version of SketchUp Viewer for 
Virtual Reality which is the latest addition to the Viewer family. SketchUp Viewer for VR is 
consistent with Oculus Rift, HTC Vive and Vive Pro headsets also; moreover that, SketchUp 
Viewer also supports the plethora of Windows Mixed Reality VR headsets with the latest 
release of SketchUp Viewer for Windows Mixed Reality. 

About VR or Virtual Reality: 

Virtual Reality or VR is a new way of using computer technology in creating a simulated 
environment and its most recent added component is the head-mounted display or HMD. 
Human beings are visual creatures and display technology is often the single biggest difference 
between immersive VR systems and traditional user interfaces. Virtual Reality copies a realistic 
environment that allows builders to contact with a particular structure using a series of scanned 
images. It is an important form of automation as it uses programmed 3D scans that are very 
perfect and not prone to human error. It can simulate as many senses as possible like vision, 
hearing, touch even smell but the only limits to near-real VR experiences are the availability of 
content and low-cost computing power. 

SketchUp Viewer for Windows Mixed Reality: 

It has made possible to engage colleagues and clients in experimental design review which is a 
powerful and new way to measure, coordinate and communicate in mixed reality. With the use 
of any Windows Mixed Reality headset like VR or HoloLens, any team and teammates can 
virtually inhabit a design, helping to facilitate clear and efficient communication about complex 
spatial issues. Besides that there will be also the ability to interact with the designs as virtual or 
holographic scale models, supplementing or alleviating the need to build physical models of the 
projects. The application also has many of the viewing, navigation and information tools that 
SketchUp users are habitat in using; users can easily fly around the project models by choosing 
from the list of the scenes created in SketchUp or can toggle layer visibility on-and-off to 
control model visibility or can use the Tape Measure tool and Entity Info tool to get quick view 
about the model. SketchUp Viewer is free to install and needs that users sign in a Trimble 

SKETCHUP VIEWER WILL HELP TO EXPERIENCE ALL 

THE REALITIES 

http://www.sketchup-ur-space.com/2019/june/sketchup-viewer-will-help-to-experience-all-the-realities.html
http://www.sketchup-ur-space.com/2019/june/sketchup-viewer-will-help-to-experience-all-the-realities.html
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Account; just an active SketchUp Pro or SketchUp Studio subscription is needed to access all 
application features. 

SketchUYp team also updated the AR/VR Extension for SketchUp Pro for easily publishing 
SketchUp Projects to any AR/VR device. Here is a little description of all SketchUp viewer apps: 

o SketchUp Viewer for Mobile: It gives the power to view designs on any iOS and Android device; 

also supports AR model viewing on ARKit and ARCore enabled devices. 

o SketchUp Viewer for VR: It brings the projects to life in VR; this app supports Oculus Rift, HTC 

Vive and Vivo Pro headsets. Users can download a Windows Installer from the My Apps page at 

sketchup.com. 

o SketchUp Viewer for Windows Mixed Reality: It is designed to support the ever-expanding list 

of mixed reality headsets offered by Microsoft and its partners. It can be installed from the 

mIcrosoft Store and is available for users with an active SketchUp Pro or SketchUp Studio 

subscription. 

Source: wwww.blog.sketchup.com 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

https://blog.sketchup.com/article/now-you-can-experience-all-realities-sketchup-viewer
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SketchUp is an essential tool in 3D printing and SketchUp Extension warehouse is full of tools 
that are essential in the 3D printing and creating 3D printed models, such as CleanUp3. 

About CleanUp3: 

CleanUp3 is an essential tool for 3D printing which is created by Thomas Thomassen, who is a 
Modelmaker with a large desire for physical, digital and traditional design in most genres of the 
trade. He has focused on webdesign/programming and 3d visualizations and he has specialized 
in 3D modeling, SketchUp, webdesign, graphic design and web programming. This tool checks 
and simplifies the geometry of every SketchUp model and it combines multiple faces, 
eliminates extraneous data and erases any lines that don’t make a face. 

CleanUp3 options: 

Two of the most useful CleanUp3 options are Erase Duplicate Faces and Repair Split Edges, 
which can be enabled in the CleanUp3 menu. Usually Duplicate faces and split edges are errors 
that necessarily appear in the SketchUp 3D model while working in SketchUp and they drive 3D 
printer nuts. But both these two errors are difficult to recognize and repair manually. Besides 
that, it is also a great tool at simplifying STL files or 3D-printable files that need to import into 
SketchUp. 

Features of CleanUp3 

o It fixes duplicate component definition names in model scope 

o Also clears unused items 

o It can erase hidden geometry 

o Also erases duplicate files 

o Erases lovely edges except edges on cut plane 

TIPS & 
TRICKS 

 

CLEANUP3 TOOL FROM SKETCHUP EXTENSION 

WAREHOUSE 
 

http://www.sketchup-ur-space.com/2019/june/cleanup3-tool-from-sketchup-extension-warehouse.html
http://www.sketchup-ur-space.com/2019/june/cleanup3-tool-from-sketchup-extension-warehouse.html
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o Can remove edge material 

o Repairs split edges 

o Creates smooth and soft edges 

o Then put edges and faces to Layer0 

o Can merge identical materials 

o Also merge connected co-planer faces 

Menus & Toolbars: Plugins>CleanUp 

About SketchUp: 

SketchUp or Google SketchUp is mainly a3D modeling computer program that is used for a 
broad range of drawing applications used by architects, interior designer, landscape architects, 
civil and mechanical engineers, film and video game designers also. SketchUp can be getting as 
a freeware version named SketchUp Make and a paid version with many more extra benefits 
called SketchUp Pro. SketchUp is software from Trimble Company and there is an online library 
of free model congregations and 3D Warehouse to which users can add other models; besides 
that, the program has drawing layout functionality with variable ‘styles’, supports third-party 
‘plug-in’ programs hosted on the Extension Warehouse to supply other abilities and enables 
placement of its models in Google Earth. 

About Extension Warehouse: 

It is an online resource with various plug-ins developed made especially for SketchUp and these 
extensions help to add some special tools and features to SketchUp. These extensions can be 
found for any particular application like drawing or 3D printing and some industry specified 
tools for architecture, interior design, construction and many more. So basically in this 
Extension Warehouse people can do the following things: 

o Users can search extensions by name or as per the functionality. 
o They can also install various extensions with a single click of a button. 
o Or users can also control all the extensions from easy-to-use location in the My 

Extension page. 

Source: wwww.extensions.sketchup.com 

https://extensions.sketchup.com/en/content/cleanup%C2%B3
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SketchUp’s Tape Measure Tool works as a Protector Tool and comes with the Measurements 
box that helps users to resize the whole model with a single measurement. 

Tape Measure Tool is the Protractor Tool in SketchUp, and the Measurements box enable users 
to model precisely; this tool will help user to resize the whole model based on a single 
measurement. This article is a full guideline about Tape Measure tool and its working methods. 

Getting started with the Tape Measure Tool: SketchUp’s Tape Measure Tool can be found in 
the Tools menu or via the Getting Started menu, Construction or Large Toolset toolbar. There is 
also a shortcut key which is T; after activating the cursor in the workspace it will be changed to 

TAPE MEASURE TOOL IN SKETCHUP 
 

http://www.sketchup-ur-space.com/2019/june/tape-measure-tool-in-sketchup.html
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a Tape Measure icon that has 2 models of measuring. With this tool, users can measure a 
distance and set precise guidelines or guide points. While the Protractor tool enables users to 
measure angles and set a precise angled guide line. 

Using Measure mode: It is a wonderful way to report measurements from a point to many 
points; to change to a new measuring point just press ESC key and pick a new point to measure 
from. This mode also acts like a scale in the model and this method is a global resize which 
means not only the model is resized before but can be done with an object locally. 

Guiding Create mode in 
SketchUp: In this mode, 
the Tape Measure Tool 
allows the users to plot 
guide lines and points in 
SketchUp to accurate 
draw in the workspace. 
This mode has also 
different methods of 
drawing guides and it 
totally depends on the 
clicked place and subject. 
1) Infinite Guide lines in 
SketchUp is created when 
users glide on an edge in 
SketchUp and click it but 
while creating the infinite 
guides using the array 
commands isn’t possible. 

2) To create guide lines that terminate with a construction point, users need to first select an 
endpoint then select the desired direction and length of the measurement. 

Deleting Guide lines in SketchUp: The Select tool or the Erase tool can help to target and 
remove areas but the Delete Guides option in the Edit menu which will delete all lines and 
points within the current context of the model. So if the user is within a group or component 
and choose this option then it will remove all guides within that context but not outside. 

Managing and deleting Guide lines in SketchUp using extensions: The right way to manage 
guide lines and guide points in SketchUp by using an extension which is known as TIG’s 
Construction Line Delete via Context extension that extends SketchUp by adding further 
options while Right clicking in an existing Guide Line. To install this extension, users need to go 
to the Extension Store in SketchUp, then need to search feature and type guide and choose the 
extension and install it. Now in SketchUp, users have access to more deletion and layer 
management options for Guide Lines and Points via the context menu; this option also has 
placing Guide Lines and Guide Points on dedicated layers, deleting Guide Line and Guide Points 
from the active selection or applying it to both Guide Lines and Guide Points. 
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Source: wwww.sketchucation.com 

 

 

 

 

Maciej Fijalkowski is the one member among the founders of the VR Sketch in SketchUp, he and 
his team is working on developing VR with SketchUp to make it more accessible. 

Maciej Fijalkowski is the surfer, programmer and climbing gym designer about the current state 
of VR industry and the one behind the VR Sketch extension. He is basically from Łódź, Poland 
but now living at Cape Town Area, South Africa. He went to Warsaw for study; he always 
wanted to go and study abroad but couldn’t afford so he started to explore more as a traveler. 
He also worked at the University of Warsaw at the Center for Mathematical and Computational 
Modeling; while working there and being a student he got into Google Summer of Code and 
became interested in Pypy. 

Later his company has introduced a new concept into the Sketch Up word with VR Sketch which 
enables the creation, manipulation and presentation of models in a fully immersive virtual 
reality environment. 

A little about VR Sketch: It is an extension for SketchUp which gives anyone the ability to 
create, edit and view their models in Virtual Reality. It also gives designers the ability to 
communicate space that clearly allows them well informed decisions to make with instant 
feedback. VR Sketch is a small but a dynamic company which plans to revolutionize the thinking 
of people about the way of design and faster design. The landscape of hardware abilities will 
only improve and everyone can see more and more design work done in VR. Sketch will keep 
iterating quickly to deliver cutting edge solutions for more years. 

Inspiration behind VR Sketch: As per his words, during the process of designing and creating a 
new rock climbing gym, he purchased a VR headset as a help in visualizing projects. Though 
SktechUp is a very easy to learn but it can be difficult while mapping of 2D screens to 3D space. 
So they thought to make something which will help to solve this problem and thus they started 
the company in April 2018. Maciej is now living in Cape Town with his co-founder, Duncan 
Fraser who is an architect and travels often. 

Projects: The team has handled many things together in past but from a long time they only 
focused on a project called Pypy which is an open source software for a faster way to run 
Python code. VR Sketch is their first venture into architecture and design which has introduced 
to the through SketchUp 3D Basecamp with greater diversity in those attending versus the 
Python conferences. VR Sketch needs less of any skills which a trained architect must have and 
helps architects to work more easily on the 3D models. 

ABOUT MACIEJ FIJALOWSKI OF VR SKETCH 
 

https://sketchucation.com/resources/tutorials/beginner/1943-complete-guide-for-sketchup-tape-measure-tool
http://www.sketchup-ur-space.com/2019/june/about-maciej-fijalowski-of-vr-sketch.html


 
 

                           25 | P a g e  
 

VR Sketch works with all the high-end hardware like HTC Vive, Oculus Rift those with touch 
controllers and some mixed reality headsets. They have been working on more major headsets 
which will be function by Oculus Quest. The team has focused on doing things well for the 
higher-end devices and consider the availability of any design tool to be a main consideration. 

Industry trends to follow for future app development: According to them, much of 3D design 
will move into the VR space and everyone will see huge iterations in hardware design. Headsets 
will be lighter and more affordable and controllers will be less clumsy. Software side will also be 
upgraded with major changes; this huge evolution and interconnection between hardware and 
software in the VR industry will create many more opportunities for them. Now they are 

working on a cloud-
enabled collaboration 
which help users in 
working on a model 
with distant team 

members 
simultaneously and 
keep a full version 
control. 

Dream Project: He is 
really interested in 
urban design and with 
an unlimited budget, he 
would be involved in 
developing a “Chartered 
City” as theorized by 
Paul Romer, where it is 
possible to play with 
new ideas every time. 

Source: wwww.blog.ske
tchup.com 

 

 

 

 

SketchUp users are pro in creating different textures and models using various textures from 
the Extension Warehouse; similarly they can go from SketchUp to Unity with PBR materials. 

GOING FROM SKETCHUP TO UNITY USING PBR 

MATERIALS 

 

https://blog.sketchup.com/article/dream-it-design-it-and-experience-it-maciej-fijalkowski-vr-sketch
https://blog.sketchup.com/article/dream-it-design-it-and-experience-it-maciej-fijalkowski-vr-sketch
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This article will clearly describes about PBR materials and the way of going back on the PBR to 
Unity 5.6 pipeline workflow for SketchUp through some easy steps. 

About SketchUp: SketchUp or Google SketchUp is mainly a 3D modeling computer program 
that is used for a broad range of drawing applications used by architects, interior designer, 
landscape architects, civil and mechanical engineers, film and video game designers also. 
SketchUp can be getting as a freeware version named SketchUp Make and a paid version with 
many more extra benefits called SketchUp Pro. SketchUp is software from Trimble Company 
and there is an online library of free model congregations and 3D Warehouse to which users 
can add other models; besides that, the program has drawing layout functionality with variable 
‘styles’, supports third-party ‘plug-in’ programs hosted on the Extension Warehouse to supply 
other abilities and enables placement of its models in Google Earth. 

PBR: PBR or Physically Based Rendering is a method of shading and rendering that provides a 
more perfect representation of how light interacts with the surfaces. PBR is also referred to as 
Physically Based Shading depending on the aspect of pipeline being discussed; PBR is usually 
specific to shading concepts and specific to rendering and lighting. Though, both these terms 
describe the process of representing assets from a physically accurate standpoint. 

SketchUV: It is an UV mapping tool which is used to draw spherical, cylindrical, planer, tube, 
box, quad shapes and can do save, load, export and import. SketchUV is designed to be easier 
to use and UV mapping in general takes some time to get use to. The features are noted here: 

o It can draw planar, cylindrical and spherical UV projections at any orientation 

o It can be used in Box mapping 

o Tube mapping- it can be a great tool for objects created using follow-me tool 

o It can do Quad face mapping 

o It can also move, rotate and scale UVs 

o It can draw Triangulate geometry and remove distorted textures 

o It also save UVs and Load UVs where change materials and maintain UVs 

o It can export and import UVs using third party UV mapping software 

Steps to go from SketchUp to Unity using PBR material: 

o Before beginning the process users need to install SketchUV extension for SketchUp 

from Extension Warehouse. 

o Then took the PBR textures and apply it on the model. 

o At last use the Pixplant for seamless texture and render map creation as this is powerful 

and easy to use. 

o For detailed process go to wwww.sketchucation.com 

Source: wwww.sketchucation.com 

https://sketchucation.com/resources/tutorials/advanced/1930-skethup-to-unity-pbr-workflow
https://sketchucation.com/resources/tutorials/advanced/1930-skethup-to-unity-pbr-workflow
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With the new upgrade version SketchUp Pro has introduced twelve new templates for 
SketchUp Extension Warehouse to make modeling in SketchUp more fun than before. 

Blogs 

 

ADVANCED TEMPLATES IN SKETCHUP PRO 
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According to the developers, SketchUp Free is the simplest, consistent 3D modeling till date 
that will help the user to access, learn and share the models with others easily. It has been 
more than a year at SKetchUp Headquarters with huge amounts of coffee consumed and after a 
long wait, SketchUp HQ finally released SketchUp Pro’s new version SketchUp Pro 2019. 

The whole SketchUp team has been discussing to bring SketchUp lovers the newest 
development in the life of their products; they proudly announced a brand new way to 
purchase all the SketchUp products which is the SketchUp Subscription. They have offered the 
best value so that users and SketchUp lovers can easily choose the perfect combination of 
SketchUp for every project, workflow or creative concept. 

This is a real opportunity to challenge the team itself to earn users’ business every single day by 
continuously improving the tools which are needed and loved whole year. The new ways to buy 
SketchUp is on their website; still the team has been working to bring subscriptions for years as 
according them it is the best way to deliver more value to the users in a single package. Their 
shift in new business will make it easier for new users to buy SketchUp and for current users; 
even more SketchUp products can be easily available. Besides that, this shift in business will 
help to keep them accountable to run business by releasing new features as often as possible; 
this is a challenge for them which they have taken proudly and moved process from an annual 
update cycle to a continuous cycle. 

SketchUp users have introduced with the new features of SketchUp Pro 2019 and with this the 
SketchUp team has added 12 new templates to make modeling in SketchUp more fun. Here are 
the names of the templates mentioned below: 

 Extra X-Ray Template 

 Super jitter Template 

 Big Axis Template 

 Outer Space Template 

 Under The Sea 

 Snow Day Template 

 More Marc 

 Bird Box Challenge Template 

 Rainbowland Template 

 There Is No Up Template 

 Infinite Origins Template 

 Night Time Template 

Some of them include the mode “Dark mode” for the night time designs; “Rainbowland” is a 
little happier and more colorful while “Big Axis” helps to get back in the axis again. These new 
templates can be accessed by pulling them up in the template directory and scrolling towards 
the bottom. 

Source: wwww.blog.sketchup.com 

https://blog.sketchup.com/article/be-first-get-them-advanced-templates-sketchup-pro-april-fools
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SketchUp is full of various 3D models, tools and extensions which is a little tough to handle for 
beginners, creating a Polygon in SketchUp with some easy tools is good start for beginners. 

Creating different figures in SketchUp is an easy work which can be done with the help of some 
tools found in this software. In every article we discuss about some complex thing which can’t 
be done without applying lots of extensions and tools but these are strictly for professionals 
who have been using SketchUp for over years. Beginners or novice users are not fully aware 
about all these extensions, that’s why we have come up with a simple item this time which can 
be useful for them 

CREATING POLYGONS IN SKETCHUP IN 5 

SECONDS 
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About SketchUp: SketchUp or Google SketchUp is mainly a 3D modeling computer program 
that is used for a broad range of drawing applications used by architects, interior designer, 
landscape architects, civil and mechanical engineers, film and video game designers also. 
SketchUp can be getting as a 
freeware version named 
SketchUp Make and a paid 
version with many more extra 
benefits called SketchUp Pro. 
SketchUp is software from 
Trimble Company and there is 
an online library of free model 
congregations and 3D 
Warehouse to which users can 
add other models; besides that, 
the program has drawing layout 
functionality with variable 
‘styles’, supports third-party 
‘plug-in’ programs hosted on 
the Extension Warehouse to 
supply other abilities and 
enables placement of its models 
in Google Earth. As SketchUp 
users are most of architects, designers, builders, makers and engineers etc. who works hard to 
give a nice shape to our physical world, they need great tools to do the work. 

In this article, we will see the steps of creating a polygon using some simple tools in SketchUp 
but before that we need to know a little bit about polygon. 

The Polygons are mainly two-dimensional closed figure which are made up of some straight 
lines and here each line segments intersects exactly at the endpoints. 

Creating equilateral polygons in SketchUp is just a matter of seconds as it is not necessary to 
draw each side manually. Here are the steps: 

 At first users need to select the Shape tool from the toolbar or can press C for the 

shortcut. 

 At the bottom right corner there is a status bar where they need to specify the number 

of sides after selecting the shape tool. Here users can type anew number and SketchUp 

will make a new equilateral shape with that number of sides. 

 After specifying the number of sides, SketchUp will ask for the radius of polygon and it 

will be an inscribed polygon. 

Source: wwww.designerhacks.com 

 

https://designerhacks.com/polygons-sketchup/
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Helix Along Curve is another Plugin from SketchUp Extension Warehouse which helps to create 
helix tubing along a pre-picked curve in SketchUp. 

SketchUp Extension is full of many plugins which help to create various kinds of 3D models and 
also helpful in 3D printing for any project. Helix Along Curve is another extension from the 
SketchUp Extension Warehouse which creates helix tubing along a pre-picked curve in 
SketchUp. The dialog in it is used to set several parameters and options; it is can be used to 
create helical shapes such as springs, seams and many more. 

About Extension Warehouse: It is an online resource with various plug-ins developed made 
especially for SketchUp and these extensions help to add some special tools and features to 
SketchUp. These extensions can be found for any particular application like drawing or 3D 
printing and some industry specified tools for architecture, interior design, construction and 
many more. So basically in this Extension Warehouse people can do the following things: 

o Users can search extensions by name or as per the functionality. 

o They can also install various extensions with a single click of a button. 

o Or users can also control all the extensions from easy-to-use location in the My 

Extension page. 

Helix Along Curve extension initially grow with the need of covering some design requires in 
some personal projects. This plugin also allows creating different types of helix easily and 
quickly by previously selecting a line or curve which can be opened or closed. The program will 
automatically guess this and ask to generate a closed propeller in the case of a closed curve. 

Here are some different options that can be done with the help of this extension: 

o Users can give a value for the start radius of the propeller and another for the end. 

o They can also define the number of turns of the helicoids. 

o This extension can specify the number of straight parts that invent each spin of the helicoid. 

o It modifies the helix construction start angle. 

o If users set the level of ‘noise’ then they can add a different random value related to the 

radius of each turn of the helicoids. Here the intensity of the noise will be greater when the 

value entered is closer to 1. 

HELIX ALONG CURVE PLUGIN FOR SKETCHUP 
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o Users can choose between five different options for a parameter called “adherence to the 

curve” which allows them to know whether the helicoids will follow the curve strictly and 

suddenly or smoothly. 

o There is an option called “Calculation mode” which overview in a simple way multiple 

internal parameters that would be difficult to understand; in this matter, users can soften 

the curve a little bit. 

o There is a possibility to specify the direction of rotation of the helicoid. 

o Users can create the helicoid only with lines or with a circular tube. 

o If they choose to create the tube, can define its radius and also can specify the number of 

sides of the tube. 

Source: wwww.3dalbertsoft.wordpress.com 

 

 

  

https://3dalbertsoft.wordpress.com/plugins/
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SketchUp team always tries to make the experience with SketchUp better and unique every 
time for the users, when users demand a new place of learning skills they started SketchUp 
Campus. 

SketchUp learners and users always demand something more from SketchUp professionals and 
SketchUp team; all the users and beginners want something new where they go through all the 
SketchUp plugins, guidance to work on it and many more designs which can be used in their 
further projects. From this demand, the idea of SketchUp Campus has come where users can 
learn more deeply about contents also share their ideas with others. 

About SketchUp: 

SketchUp or Google SketchUp is owned by Trimble Inc., a mapping, surveying and navigation 
company. It is mainly a 3D modeling computer program that is used for a broad range of 
drawing applications used by architects, interior designer, landscape architects, civil and 
mechanical engineers, film and video game designers also. SketchUp can be getting as a 
freeware version named SketchUp Make and a paid version with many more extra benefits 
called SketchUp Pro. SketchUp is software from Trimble Company and there is an online library 
of free model congregations and 3D Warehouse to which users can add other models; besides 
that, the program has drawing layout functionality with variable ‘styles’, supports third-party 
‘plug-in’ programs hosted on the Extension Warehouse to supply other abilities and enables 
placement of its models in Google Earth. As SketchUp users are most of architects, designers, 
builders, makers and engineers etc. who works hard to give a nice shape to our physical world, 
they need great tools to do the work. 

SketchUp Campus: It is a unique, profound learning place with SketchUp-approved courses 
which all are created by SketchUp team members to make the learning of SketchUp more 
suitable and simpler than before. More than that, SketchUp courses and transcripts are 
translated into over 100 languages to become understand by all the users over the world. The 
languages are: 

 English, Afrikaans, Albanian, Amharic, Arabic, Armenian, Azerbaijani, Basque, Belarusian, 

Bengali, Bosnian, Bulgarian, Catalan, Cebuano, Chichewa, Chinese (Simplified), Chinese 

(Traditional), Corsican, Croatian, Czech, Danish, Dutch, Esperanto, Estonian, Filipino, Finnish, 

French, Frisian, Galician, Georgian, German, Greek, Gujarati, Haitian, Creole, Hausa, Hawaiian, 

Hebrew, Hindi, Hmong, Hungarian, Icelandic, Igbo, Indonesian, Irish, Italian, Japanese, Javanese, 

Kannada, Kazakh, Khmer, Korean, Kurdish (Kurmanji), Kyrgyz, Lao, Latin, Latvian, Lithuanian, 

Luxembourgish, Macedonian, Malagasy, Malay, Malayalam, Maltese, Maori, Marathi, 

Mongolian, Myanmar (Burmese), Nepali, Norwegian, Pashto, Persian, Polish, Portuguese, 

Punjabi, Romanian, Russian, Samoan, Scottish, Gaelic, Serbian, Sesotho, Shona, Sindhi, Sinhala, 
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Slovak, Slovenian, Somali, Spanish, Sudanese, Swahili, Swedish, Tajik, Tamil, Telugu, Thai, 

Turkish, Ukrainian, 

Urdu, Uzbek, 

Vietnamese, Welsh, 

Xhosa, Yiddish, Yoruba, 

Zulu. 

SketchUp Campus helps 
users to roam from 
SketchUp beginners to 
professional with 
different tracks and 
consecutive courses to 
make a speedy tour. 
The courses are divided 
in short videos and 
quizzes which help to 
learn topics like 
Rendering with 
Photoshop, Layout and 

SketchUp 
Fundamentals fun, 
quick and easy. All the 
quiz answers provide 

quick feedback and help the users to find out their successive places and the places where 
improvement is needed. 

These courses can be taken at users’ own speed and repeat them as per their need; more than 
that, users can track their progress and understand their lacks, no matter where they start or 
stop. 

Procedure to get SketchUp Courses start: The following steps will help to start the course: 

 Go to the following path- https://learn.sketchup.com/ 

 Then sign in with SketchUp login or the Google account 

 Now choose a track and start to learn what you want 

The best part is that, the learning library will develop over time which will help to grow skills of 
every user. SketchUp team is eagerly waiting for the responses of the users about this Campus, 
it’s learning process or any kind of addition, improvement which is needed. 

Source: wwww.blog.sketchup.com 

 

https://blog.sketchup.com/article/welcome-sketchup-campus

